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1. INTRODUCTION. 
 
The "NetboxRTC" is an application that allows to control the routing and mixing of inputs to 
outputs of the system on NETBOX 8 AD MX Audio Router 16x16, NETBOX 32 AD MX Audio 
Router 64x64 and NETBOX DSP and the processing of inputs and outputs on NETBOX DSP. 
As any mission-critical equipment this application has been designed to safeguard operation 
against user errors and equipment failures. 
 

NOTE: A standard NETBOX 32/8 AD can be converted into a high-performance summing and 
distributing matrix for Dante

TM
/AES67 AoIP, digital and analog audio switching by mixing 

specific firmware versions and a user license (for more information, please consult the user's 
manual of the unit). 
 

The "NetboxRTC" application allows setup, modifying and controlling in real time the audio 
matrix. Any event or action such as salvos, macros, individual crosspoints, physical and virtual 
GPOs can be triggered as follows: 
 

- Manually. 
- Programmed to be executed automatically in a schedule. 
- Manually executing a schedule. 
- Through physical GPIs. 
- Through virtual GPIs. 
 

More effective learning is achieved through training given by specialized technicians with broad 
knowledge of the system. This document is for reference purposes, and it's organised according 
to the drop-down menus on the menus bar. 

 
2. SOFTWARE PACKAGES INSTALLATION. 
 
The following steps needs to be observed when installing the "NetboxRTC" Client and Server 
applications. Any installation of these software packages on a computer should be 
accomplished using Administrator privileges for Windows. 
 
2.1. "NetBox Tool". 
 

1. Install the "NetBox Tool" application (version 2.0.0.20 or higher). The auto run USB key 
furnished with the unit contains the executable file that installs this application (see 
section 3.2.1 of the user's manual of the unit). 

 

2. In the case of the NETBOX 32/8 AD MX Audio Interfaces, these should have the 2.xx or 
newer firmware version for CPU and FPGA. 

 

 If you need to upgrade the unit from a version 1.xx (older than the 2.xx) or setting up a 
 new NETBOX 32/8 AD MX, it's necessary to execute a restart to the initial parameters 
 by means of the "Factory" button (see section 3.2.2.1 of the user's manual of the unit). 
 

3. In order to be able to use the "NetboxRTC" Client and Server application, it's necessary 
to obtain a "NetboxRTC" license for the unit. 

  

 You can check if the unit has a license ("REGISTERED") or not ("LOCKED") in the 
 "Configurations" submenu. If the unit is "LOCKED" you can activate the license in this 
 submenu: see section 3.2.2.1 of user's manual of the unit.   

 

 It's recommended to turn off and on the unit after activating the license. 
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2.2. Database engine. 
 
If there is no MySQL or MariaDB on the PC where the database is to be installed, install the 
corresponding version (32 or 64 bits) that is located in the auto run USB key furnished with the 
unit. You can find it going through the following screens: 
 

    
 

 

 
If you install MariaDB, when you reach the step "User settings" mark all the options and set as 
the password aeq. Continue by clicking "Next" for the remainder of dialogues popping up. 

 

 
 

 

aeq 
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2.3. "NetboxRTC". 
 

1. Install the "NetboxRTC" application (version 2.0.0.20 or higher). The auto run USB key 
furnished with the unit contains the executable file that installs this application. You can 
find it going through the following screens: 

 

    

 

   

 
 Installing the application is simply a matter of following the on-screen instructions as 
 they come up: 
 

 
 

2. Once the "NetboxRTC" application is installed (by default, in C:\AEQ\NetboxRTC), start 
it up by double-clicking the icon displayed on the desktop: 
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3. The first step will be to create and connect to the new NETBOXRTC database. 
 
4. When starting the application for the first time, the following screen will appear and in 

which you can check and configure the connection with the database that the 
"NetboxRTC" manages. 

 

 
 

5. The "Test connection" button checks if there is a connection to the SQL server (by 
default, "Host Name" is localhost, "User name" is root and "Password" is aeq). 

 

 
 

 In case that you are installing "NetboxRTC" also in a different PC that the one where 
 database is installed, the netboxrtcuser user with aeq password must be used and 
 "Host Name" will be the IP address where the database is stored. 
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6. The "Test connection Database" button checks the connection to the database. 
 

 If it's not possible to connect to the database but with the server, an error message will 
 appear: 
 

 
 

 This can be considered as normal as since it may be that the database has not been 
 created yet. In this case a new button will appear at the lower left, "Create Database", 
 which will allow you to create the database at that time. 

 

 
 

 Then two confirmation windows will appear. 
 

      
 

 After confirmation, the database will be created. 



 
 

AEQ NETBOX RTC 

 
 

9 

 
 
 NOTE: In the case of an already existing MySQL or MariaDB database engine, 
 "UserName" and "Password" fields may be different from the ones that you have 
 indicated above. 
 

 If you don’t remember or are unaware of the "User name" and "Password", other 
 possible combinations are root and aeqaeq, or root and aeq, or netboxrtcuser and 
 aeqaeq, or systeluser and aeqaeq. 

 
7. Once the database has been created, the validation window will appear for the 

application (this window will appear any time you open "NetboxRTC"). This is where our 
user and password must be validate: the default user is "ADMIN" and the password is 
"AEQ" (in this case there is no difference between capital and lower case letters). 

 

 
 
 If there are connection problems with the NETBOX, it may be necessary to assign 
 administrator permissions to the "NetboxRTC.exe" executable. 
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2.4. "Netbox Server". 
 

1. Install the "Netbox Server" application (version 2.0.0.3 or higher). The auto run USB key 
furnished with the unit contains the executable file that installs this application. You can 
find it going through the following screens: 

 

    

 

   

 
 Installing the application is simply a matter of following the on-screen instructions as 
 they come up: 
 

 
 

2. Once the application is installed (by default, in C:\AEQ\NetboxServer), start it up by 
double-clicking the icon displayed on the desktop: 
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 Then the initial screen will appear: 

 

 
 
 In the lower part of this window the IP address that will be used for the connection to 
 NETBOX unit is shown (that IP address must be of the same range than the one for the 
 unit). The date and time the application was started is also shown and, in the lower line, 
 the database you're connected to and the application version (besides date and time of 
 compilation) are shown. 
 

 If the Computer NIC has more than one IP address, it's necessary to select the one 
 that should be used for the connection to NETBOX unit (of the same range that the one 
 for the unit). In order to do that, you must press the "Select Local IP" button at the 
 lower left corner (in that case it will appear available) and then select the IP address in 
 the window that appears. 
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Observation: It's recommended that the database and "NetboxServer" are located on the same 
Computer. The .ini files of RTC and Server allows you to change some information as host, 
user, password or database. 
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2.5. Creating a list of NETBOX devices. 
 
Once all the applications are installed, first thing to do is open "NetboxRTC" application in order 
to connect to the NETBOX unit you want to control and operate. In order to do that, you must go 
to the "Netbox List" option on the "Config" menu. Then the following tab will appear: 
 

    
 
Firstly you must press the button with the Earth icon ("Select Local IP") in order to select the IP 
address corresponding to the PC where the application is installed. When you press this button 
a window will open that reflects several IP addresses, if you have configured your Network 
Interface or NIC with several IP addresses in different ranges. When you select the IP address 
that would be appropriate and in the same range as the device that you want to control with the 
application and confirm the selection by clicking on the "OK" button, that IP address will be 
shown in the previous button. 
 

    
 
Below the "Local IP" button you will find the title "Netbox List" and immediately below this four 
buttons. 
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 Allows to add a new NETBOX device to the "Netbox 
LIst". You must select the model (NETBOX 8, NETBOX 32 
or NETBOX DSP), type in the IP Address of the device 
and give a name to it. 
 
You can also select the UDP local ports range that will be 
used by the "Netbox Server" and "NetboxRTC" 
applications in order to communicate with that device; in 
case you configure or modify the range associated to 
"Netbox Server" it's necessary to restart this 
application/service. Its functionality is focused on network 
security, since it offers the option of being able to filter in 
the routers (that support it) the UDP ports that should be 
left open for communication between the NETBOX device 
and those applications. In case that this option is not 
configured, all UDP ports must be open since the port to 
be used by NETBOX applications is random. 
 
 

 

 Allows to edit the selected device. 
 
 
 
 
 
 
 
 
 
 
 
 

 Allows to delete the selected device from the 
"Netbox List". The user will be prompted to confirm 
the deletion. All the device data will be lost 
(including salvos, macros, schedules...). 
 
 
 
 
 

 

Allows to connect to the selected device. When the control computer NIC and 
the device are in the same range of IP addresses, the unit will connect to the 
control software, server application and database and signal to the software 

that the connection is established. At the footer of 
the "NetboxRTC" application the NETBOX device 
that is connected is indicated. When there is no 
connection to the selected device it appears in red. 
 

Once the selected device is connected, the previous button changes to 
"Disconnect" and allows to disconnect it in order to select another one and 
connect to it. 

 
IMPORTANT NOTE: You must also configure a Multicast IP address for vumeters and the IP 
address where the server is hosted (see sections 6.15 and 6.16 of this manual). 
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3. APPLICATION START-UP SCREEN. 
 
When you access the "NETBOX RTC" application, the following window appears (if there is no 
default view selected). From this window you have access to all the drop-down menus that are 
explained in the subsequent sections of this document; if you connect to a device without the 
corresponding license activated (see section 2.1 of this manual), an informative screen will 
appear when you try to access to the options of those menus. 
 

 
 

At the bottom of the window, the following information is displayed: 
 

• NETBOX IP Address and name: shows the IP address and the name of the NETBOX 
that the application is pointing or trying to 
control. If in green this means that the 
connection is established and if in red this 
means that there is no connection. 

 

• Local Host: if in green indicates that there is connection to 

"NetboxServer" and if in red that there is no connection. 
 

• User: when the active user in "NetboxRTC". 
 

• Group: indicates the group that the current user belongs to. 
 

• External Sync: indicates the configured 
synchronization mode of the unit. In the case of 
NETBOX DSP the third option is not available. 

 
 

• AOIP Link: indicates the AoIP connection status of the unit. In the 
case of NETBOX 32/8 AD MX there is only 1 LED (it includes just 
one Dante module) and in NETBOX DSP there 
are 4 LEDs (1 per each possible Dante module: 
there is 1 Dante module in NETBOX DSP 64 model, 2 modules in NETBOX DSP 96, 3 
in NETBOX DSP 128 and 4 in NETBOX DSP 160). The possible status are: 

 

- Grey: Dante module is not connected or not present. 
- Green: correct operation and synchronization of Dante module. 
- Red: Dante module is present but not synchronized. 

 

• BBDD: the name of the system database that is in use to 
control the NETBOX devices. 

 

• SRV: indicates the IP Address of Server RTC. 
 

• Application version in use, date and time 
of compilation. 
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4. DROP-DOWN MENU: File. 
 
The options that are available in the "File" drop-down menu 
are described in the following sections. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
4.1. New Logical XY View. 
 
By creating a logical XY View, enables you to control the connection between a selection of 
logical lines in XY format. Each connection of an input to an output included in the view is 
presented and made at the crosspoint between the row and the respective column. 
 
The screens with real-time views can be configured according to the user’s needs. Starting with 
the minimum possible size for each logical line, the space occupied by each line is readjusted to 
fit the size of the window, thus displaying all of the lines selected in that view. If there are more 
lines than can be shown in one window, scroll bars will be displayed. 
 
The labels for each line can also be edited in real time, although when the session is closed, 
these changes will be lost, as they are momentary and depend on the use of the line at that 
particular moment. 
 
When you select "New Logical XY View", the following window appears: 
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4.1.1. Creating customized views. Customize. 
 
When "Customize…" button 
is pressed, a window that 
allows you to select the input 
and output lines that should 
be part of the view appears. 
This window allows you to 
select from the available 
analog, digital and AoIP inputs 
and outputs. There is also a 
test tone of 1KHz and +4dBu 
(-20dBFS) available. 
 
To access the list of available 
input or output lines, simply 

click the corresponding  
button. This will open the list 
of available lines to the right of 
this window. 

 

 
In the upper right part of the window there is a section that allows you to define the color that 
will appear in the XY view for the background of the labels of connected inputs and outputs: 
 

 
 
A sample of the currently selected color appears on the left. 
 

When the  button is pressed the window that allows to select the desired color (from a 
series of basic colors or by defining custom colors) will appear: 
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Once selected, the new color will appear in the section and will be shown in the next XY views 
that are created (not in the current XY view): 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

The  button allows to return to default color. It will also be shown in the next XY views that 
are created (not in the current XY view): 
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4.1.1.1. Selecting lines. 
 
You can select the lines in 
any combination - one by 
one or making a multiple 
selection clicking the lines to 
the right and holding the Ctrl 
key on your keyboard down 
and when finished clicking 
on the "Selected" single 
arrow - or select all the lines 
by clicking on the "All Lines" 
double arrow. These actions 
will move the selection to 
the left side and into the 
inputs and outputs sections. 
 
 
 
 
 

 
Any selection that is moved to the left will be part of the view and will also show at the last 
position of the list counting from above. If you need to move any of the inputs or output lines in 

the list, simply select the line and move it in the list with the green Up  and Down  arrows. 
If you need to remove any of the input or output lines, simply select the line in the corresponding 

inputs or outputs section and then click the  button. 
 

If you have made a multiple selection of either the input or output lines, this selection will remain 
on the list (inputs or outputs) to the right until you make a single selection on this list. This 

allows you to change the list view from inputs to outputs by alternatively clicking on the  

button for inputs and outputs. A second click on the  button, e.g. if clicking on the  button 
for the inputs when the list for inputs is active to the right, then you are toggling between the list 
and a preview of the XY view or panel that you are currently editing. 
 

As you will be able to see, 
the list of selected inputs 
and outputs to the left in this 
window has a counter that 
indicates the current 
number of input and output 
lines that the XY view will 
have if you save the view. 
The counter is located in the 
upper right corner, slightly 
above the title bar "Input 
Lines" or "Output Lines". 
Once finished with the 
selection of input and output 
lines, you can either decide 
to confirm the view by 

clicking on the  button 
or to discard it by clicking on 

the  button. 
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4.1.1.1.1. Test Tone. 
 
As indicated in section 4.1.1, among the available input lines there is also a test tone of 1KHz 
and +4dBu (-20dBFS), that appears at the end of the inputs list indicated in the previous 
section. That tone can be routed to any output from XY view by activating the corresponding 
crosspoint (see section 5.2) or from the context menu associated to that output line (see section 
5.3). 

 
4.1.1.2. New XY View. 
 

If you confirm with the  button, the new XY view will appear as an operational window: 
 

 
 
From left to right in the upper part of this window you will find the following buttons: 
 

 
 
The "Customize…" button opens the window to select input and output lines as explained 
above, but with the inputs and outputs for this particular XY view in the sections to the left. 
 
The remainders of the buttons are explained in the following sections. 
 
In the case of NETBOX DSP there is an additional button at the right of the previous ones (see 
section 4.1.8): 
 

 

 
When you reduce the size of this window, at a certain moment those buttons are replaced by 
the "Options" drop-down menu with the same functionality: 
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The label of each one of the input and output lines 
that form the XY view shows an audio level indicator. 
In the case of the output lines the indicator will be 
square when the line is non summable. The levels 
and associated color are: 
 

• Grey: less than -60dBFS  

• Green: between -60 and -20dBFS  

• Yellow: between -20 and -6dBFS  

• Red: more than -6dBFS   NOTE: 0dBFS = +24dBu  
 

 
 
In the case of NETBOX DSP, at the right or under the label of the input or output lines where a 
process has been activated a yellow indicator of active process is shown. 
 
In the case of NETBOX DSP and NETBOX 32/8 AD MX, at the right or under the label of the 
input or output lines where an AGC (Automatic Gain Control) has been activated a light blue 
indicator of active AGC is shown. 

 

  
 
 
Finally, the label of the Dante input or output lines, if a color has been defined for the vumeters 
frames (see section 6.8), next to the audio level indicator an additional indicator appears with 
the color selected for those frames: 
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4.1.2. Rename XY View. 
 

 
 
The "Rename View" button allows you to change the name of the view. By default, the 
application provides a name that consists in the name of the user that has created the view plus 
the date and time of the generation of the view. Just overwrite the default name with the 
preferred name in the "Rename Connection View" box, for example a name that correctly 

describes the XY view. When modified, either click the  button to accept the name 

change or the  to discard the change. 
 
When you reduce the size of the window, at a certain moment those buttons are replaced by the 
"Actions" drop-down menu with the same functionality: 
 

     
 
4.1.3. Save XY View. 
 
When you want to save the XY view to the database you need to click on the "File" drop-down 
menu and then select "Save Workspace As…". This opens the "Save Workspace" window: 
here you can name the workspace, set the workspace as default when opening the application 
("Set as Default Workspace for current User") and define what users should have access to 
the workspace in the application. 
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4.1.4. Save Status XY. 
 
When you click on the "Save Status XY" button, this will open a line in the window that allows 
you to save the XY view as well as the connection/disconnection status of the crosspoints. See 
section 4.4 of this manual. 
 

 
 
You can assign a new name to this "Status XY" or even overwrite an existing one by selecting 
the "Overwrite" option and then selecting one of the "Status XY" previously saved. 
 

 

 
4.1.5. View Salvos. 
 
When you click on the "View Salvos" button, this will open a line in the window that allows you 
to select a salvo from the "Select Salvo" drop-down list. If no salvos have been recorded, the 
list will for obvious reasons be empty. Also, when this line in the window is opened the "View 
Salvos" button will change legend and read "Hide Salvos" (when you click on it that new line is 
hidden). If you select a salvo from the drop-down list, the "Take", "Release" and "Override" 
buttons to the right of the list will become active. 
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The "Take" button will activate the salvo and execute the defined actions: 
connect/disconnect and/or protect/unprotect crosspoints. In case any of those 
crosspoints is protected yet, no action will be executed on it when activating the 
salvo. 

 

The clicking on the "Release" button will deactivate the salvo and execute the 
opposite actions on crosspoints. In case any of them is protected yet, no action 
will be executed on it when deactivating the salvo. 

 
If the taking of a salvo implies such protected crosspoints, it's possible to 
execute the salvo completely, breaking those protections, by clicking on the 
"Override" button. 

 
When you reduce the size of the window, at a certain moment those buttons are replaced by the 
"Actions" drop-down menu with the same functionality. 

 
If a salvo is marked as critical ("Request 
confirmation" option has been selected when 
creating the salvo, as described later on in this 
manual) the user will be prompted to confirm the 
action with a warning message. If the salvo is not 
marked as critical, it will be executed immediately if 
the user has the rights or privileges for the selected 
salvo. 
 
 
 

4.1.6. View Macros. 
 
When you click on the "View Macros" button, this will open a line in the window that allows you 
to select a macro from the "Select Macro" drop-down list. If no macros have been recorded, the 
list will for obvious reasons be empty. Also, when this line in the window is opened the "View 
Macros" button will change legend and read "Hide Macros" (when you click on it that new line 
is hidden). If you select a macro from the drop-down list, the "Exec" button to the right of the list 
will become active. 
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The "Exec" button will run all the actions that have been defined in the macro 
including connection/disconnection and/or protection/unprotection of crosspoints 
and activation/deactivation of salvos or GPOs. In case any of the those 

crosspoints is protected yet, no action will be executed on it when activating the macro. 
 

If the taking of a macro implies such protected crosspoints, it's possible to 
execute the macro completely, breaking those protections, by clicking on the 
"Override" button. 

 
When you reduce the size of the window, at a certain moment those buttons are replaced by the 
"Actions" drop-down menu with the same functionality. 

 
If a macro is marked as critical ("Request 
confirmation" option has been selected when 
creating the macro, as described later on in this 
manual) the user will be prompted to confirm the 
action with a warning message. If the macro is not 
marked as critical, it will be executed immediately if 
the user has the rights or privileges for the selected 
macro. 
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4.1.7. AGC. 
 
When you click on the "AGC" button, this will open the "Active AGC" informative window that 
shows a list of the input and output lines where an AGC (Automatic Control Gain) has been 
activated and also the configuration of those controls in dBFs. See section 5.3.2 of this manual. 
 

 
 

 
 
In the case of NETBOX 32/8 AD MX you can activate AGCs only in the input and output Dante 
lines, not in the analog or digital lines. 
 
 
4.1.8. Processes. 
 
This option only appears for NETBOX DSP. When you click on the "Processes" button, this will 
open the "Active Processes" informative window that shows a list of the input or output lines 
where a process has been activated and also the type of active process: 
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4.2. New Vumeters View. 
 
The "New Vumeters View" option of the "File" menu allows you to create a vumeters view to 
visualize the levels of the selected Dante input and output lines in order to control them. When 
you select this option the following window will appear: 
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From left to right in the upper part of this window you will find the following buttons: 
 

 
 
The "Add" button allows you to add new input and/or output vumeters and the "Delete" button 
allows you the eliminate the selected vumeters. The "Left" and "Right" buttons allow you to 
move the selected vumeter. The "Rename View" button allows you to rename the vumeters 
view. 
 
The available vumeters will depend on the number of available input and output Dante lines. In 
order to be able to visualize the vumeters it's necessary to configure an associated Multicast IP 
address (see section 6.15 of this manual). 
 
When you press the "Add" button the following window will appear: 
 

 
 
You can select Dante input or output lines, by pressing the corresponding button, one by one or 
making a multiple selection (clicking on one line and holding the Ctrl key in order to select more 

lines). Once the selection is finished, either click the  button to add more lines or the 

 button to discard the selection. 
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The "Logical Lines" option of the "Config" menu allows you to choose the color you want to 
visualize the frames of the vumeters (see section 6.8 of this manual). 
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4.3. Add Talkback. 
 
This option of the "File" menu will open the dialogue window that contains the list of "Talkback" 
groups previously created: 
 

 
 
This window allows you to open the selected "Talkback" group by pressing the "OK" button. It 
will open the window that allows you to execute the selected "Talkback" by pressing the 
"Execute" button (confirmation is required).  
 

   
 
When the "Talkback" is executed all the existing crosspoints towards the output lines that are 
part of it will be deleted (towards the line defined as "PFL" as well as towards the ones defined 
as "Talk") and, only in the case of a NETBOX DSP, the gains of all the crosspoints (activated or 
not) towards those output lines will be restored to 0. 
 
Additionally, the n-1 connections between the input lines of the "Talkback" defined as "Mute" 
and the output lines defined as "Talk" will be automatically created (each "Mute" input will be 
sent to all the "Talk" outputs except the one associated to that input when the "Talkback" was 
defined: see section 6.7 of this manual). 
 
You can execute a previously defined "Talkback" without using some of the associated lines. In 

order to do that, the button  of the lines that will not be used should be pressed (this button 

changes to  in order to indicate that that line is out of the group; it can be added again by 
pressing the button again).  
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The following example shows a series of configured crosspoints: 
 

 
 
When the TB 01 "Talkback" is executed the 3 crosspoints on the left are deleted because those 
output lines are part of the selected "Talkback". Then the corresponding n-1 connections are 
created:  
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When the "Talkback" window gets active 
looks like this. 
 
In the upper part of the window the input 
line defined as "Order" input and the 
output line defined as "PFL" output are 
shown. The following buttons are also 
shown: 
 
 

• "PFL": When you activate it the 
input line displayed on the button is 
sent towards the "PFL" output. 

• "Reset PFL": When you activate it 
the previously activated crosspoints 
to "PFL" are deactivated. 

• "MUTE OFF": When you activate it 
(it changes to MUTE) the input line 
displayed on the button is muted by 
deleting the crosspoints that send 
that line towards the defined "Talk" 
outputs. 

• "Mode PTT": Allows you to activate 
or not the PTT working mode (Push 
To Talk) of the TALK buttons placed below. By default it's active. 

• "TALK": When you activate it all the crosspoints connected to the output line displayed on 
the button are deactivated and the "Order" input is sent to it. In case that the "Talkback 
Mode" option was configured as "Attenuation 20 dB" when the "Talkback" was created, 
those crosspoints will remain but with an attenuation of 20 dB (this option is available only 
for NETBOX DSP; see section 6.7 of this manual). 

• "TALK ALL MIC TB": When you activate it, all the crosspoints connected to all the "Talk" 
outputs are deactivated (or attenuated) and the "Order" input is sent to all of them. This 
button will not appear in case that the "Talk All" option was configured as "Disabled" when 
the "Talkback" was created (see section 6.7 of this manual). 

 
In case that one of the lines selection of 
the "Talkback" is configured as 
"Program", the previous window is  
slightly different (the "Program" lines 
selection appears in first place and 
separated by a line). In this case, the 
associated TALK button will not appear 
and the MUTE OFF button will appear just 
in case that the "Mute in Program" option 
is configured as "Enabled" (see section 
6.7 of this manual). 
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In the following example, the "PFL IP 03 ST" and "PFL 05 ST" buttons have been pressed to 
send the "IP 03 ST" and "IP 05 ST" inputs to the output line defined as "PFL" ("IP 07 ST"). 
 
Also the "MUTE OFF IP 04 ST" button has been pressed to deactivate the crosspoints that send 
the "IP 04 ST" input towards all the "Talk" outputs. 
 
Finally the "TALK IP 02 ST" button has been pressed to deactivate all the crosspoints to the "IP 
02 ST" output and send the "Order" input line ("IP 07 ST") towards that output.  
 

 
  
When the "Talkback" window is closed (by clicking on the right top cross) all the crosspoints 
created towards the output lines contained in the "Talkback" are deactivated. Confirmation is 
required: 
 

 
 
 
IMPORTANT NOTE: If any of the output lines included in a "Talkback" is defined as NON 
summable, when the "Talkback" is executed the line starts to act as a summable line (although 
on the XY view the audio level indicator will keep square). When the "Talkback" is closed the 
line will return to act as a NON summable line. 
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4.4. Status XY. 
 
This option of the "File" menu will open the dialogue window that contains the list of "Status XY" 
previously saved: 
 

 
 
This window allows you to open the selected "Status XY" (by means of the "Open" button). By 
doing it, the associated XY view is opened (with all the input and output lines selected for that 
view) and all the crosspoints that should be connected or disconnected in order to leave the 
system in the same status as it was when the "Status XY" was saved will be marked: 
 

 
 
The crosspoints that will be connected/disconnected when the "Take" button is pressed are 
marked in green/red. You can also discard those connections/disconnections by pressing the 
"Clear Selection" button (or discard them and in addition protect those points by pressing the 
"Protect" button). 
 
In the example, when you press "Take" 2 crosspoints will be connected and other 2 will be 
disconnected. The other 2 crosspoints that are shown were yet connected when that "Status 
XY" was save and their status will not change. 
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4.5. All Connections View. 
 
This option of the "File" menu allows you to create an XY view including only all the input and 
output lines that are part of a crosspoint: 
 

 
 
 
4.6. Salvo to View. 
 
This option of the "File" menu will open the dialogue window that contains the list of "Salvos" 
previously created: 
 

 
 
When you select one of the salvos and press the "Open View" button, it will open an XY view 
that includes only the input and output lines that are part of that salvo. 
 
From that view you can also execute the desired action ("Take", "Release" or "Override") from 
the "Actions" drop-down menu or from the associated buttons (depending on the size of the 
salvo and therefore on the size of the associated XY view): 
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4.7. Close and Close All. 
 
The "Close" option of the "File" menu allows you to close the active XY or vumeters view and 
the "Close All" option allows you to close all the views currently open. 
 

 
4.8. Workspace. 

 
4.8.1. Open Workspace. 
 
This option of the "File" menu will open the dialogue window that contains the list of workspaces 
that are created, visible and available to the user currently operating the "NetboxRTC" 
application. 
 

 
 
This window allows you to open the selected workspace (by means of the "Open" button), make 
the selected workspace the default one for the user that is operating the "NetboxRTC" 
application (by means of the "Default" button) and also eliminate the workspace if the user has 
sufficient application privileges (by means of the "Delete" button). 

 
4.8.2. Edit Workspace. 
 
This option of the "File" menu allows you to edit the properties of the active workspace, i.e. 
modify what was defined when you saved the original workspace and as described above: here 
you can re-name the workspace, set the workspace as default when opening the application 
and define what users should have access to this particular workspace in the application. 
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4.8.3. Save Workspace As. 
 
This option of the "File" menu allows you to save the visible workspace (including XY and 
vumeters views) and assign a name that allows to recognize it from "Open Workspace" window. 
 
For each workspace you also must select the users that will have access to it and if that will be 
the default workspace for the current user ("Set as Default Workspace"). 
 
When you save a workspace previously saved, you will basically duplicate the workspace with a 
different name. 
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4.9. Log - Macro & Salvo. 
 
The "Log - Macro & Salvo" option of the "File" menu allows you to have a log of the salvos and 
macros executed by means of alarms, schedule, GPIs and Virtual GPIs. Each action has a 
different color and application associated: 
 

• Server: 
- Alarm (red). 
- Schedule (green). 
- GPI (olive). 
- Virtual GPI (blue). 

• RTC: 
- Salvo (lime). 
- Macro (yellow). 

 

 

 
4.10. Backup Database. 
 
This option of the "File" menu allows you to make a backup copy of the database and choose 
the directory to store it. 

 
4.11. Restore Database. 
 
This option of the "File" menu allows you to restore the backup copy of the database. In order to 
do that all the applications (Server and all the RTCs) should be closed and reopened then. 

 
4.12. Backup Matrix. 
 
This option of the "File" menu allows you to make a backup copy of the matrix configuration or 
restore a backup copy previously saved. 
 
When this option is selected, it will open the dialogue window that contains the list of matrix 
backups previously created: 
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For each backup it indicates the creation date, the name and the number of crosspoints and 
inputs, outputs and crosspoints gains the backup contains. 
 
The buttons available in the upper part of the window are the following: 
 

 Allows you to create a new matrix backup. In order to do that you must assign a name and 
select what will be stored in that backup. 
 

 
 
The tic-boxes under the name allows the user to choose whether the following parameters will 
be stored in the backup or not: 
 

• crosspoints. 

• protections. 

• inputs and outputs manual gains. 

• inputs and outputs AGCs (Automatic Gain Control). 

• crosspoints gains (available only for NETBOX DSP). 

• HW Switch configurations. 
 
When any of the 5 first parameters is not configured in matrix, the associated tic-box is not 
selectable. In the following example there are no protections, AGCs and crosspoints gains 
configured in matrix and that's why those tic-boxes are not available: 
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 Allows you to edit the name of the selected backup. 
 

 

 Allows you to delete the selected backup from 
the list. Confirmation is required. 
 
 
 
 
 

 

 Allows you to restore the selected backup 
from the list. Double confirmation is required 
because before restoring that backup all 
crosspoints, protections, gains, AGCs and HW 
Switch configurations of matrix will be removed. 
 
 
 
 
 
 
 
 
 
 
 
 

Once the selected backup is restored the 
"NetboxRTC" application must be restarted: 

 
 
 
 
 
 
 
 
 

4.13. Exit. 
 
This option of the "File" menu allows the user to exit the "NetboxRTC" application. Confirmation 
is required. 
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5. WORKING WITH CROSSPOINTS. 
 
5.1. Operating the XY views in the workspace. 
 
Once you have adjusted the XY view, the operational window will have this appearance: 
 

 
 
Any modification made in any of the actions detailed in sections 5.2 or 5.3 (except the ones 
regarding the precision vumeters) will be stored in the non volatile memory of the NETBOX after 
at least one minute with no changes detected in these actions. 
 
5.2. Actions on crosspoints. 
 
The following buttons, at the left corner of the XY view, allows the user to operate the matrix: 
 
 

• "Take": Activates or deactivates the selected crosspoints to 
connect (green crosspoints) or disconnect (red crosspoints) the 
respective logical lines. 

 

• "Clear Selection": Clears any selection of crosspoints on the XY 
view. 

 

• "Protect": Sets the status of the crosspoint to protect against 
incorrect actions: once activated, the crosspoint will show a pad-
lock. 

 
When you place the cursor over the 
crosspoints you wish to establish and then 
select them, the crosspoints will be marked 
green. When you press the "Take" button, 
the selected crosspoints will be activated. An 
active crosspoint is always indicated as blue. 
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If you place the cursor over one or several 
active crosspoints (marked in blue) and then 
select them, they will be marked in red. 
Pressing the "Take" button deactivates the 
selected crosspoints, that will be cleared 
from any colour. 
 
 
 
 
 
 
 
 
 
If a set of active and inactive crosspoints are 
selected (they will be marked in red and 
green respectively) and "Take" is executed, 
the "NetboxRTC" application will execute 
both the connections and disconnections, i.e. 
it's possible to both activate and deactivate 
multiple crosspoints with the same "Take" 
action. 
 
 
 
 
 
 
 
At the bottom of the window, the input and output associated with each crosspoint will be 
displayed when the mouse cursor is placed over that crosspoint. 
 

 

 
If you click over an input of the XY 
view, the active connections of that 
input appear in the lower bar of the 
view, that is, the outputs that input 
is connected to. 
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If you do the same over an output, 
its active connections will also 
appear, that is, the inputs 
connected to that output. 
 
 
In both cases a maximum of 5 
signals is shown: if there are more 
than 5 signals suspension points 
will be shown. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
5.3. Actions on lines or crosspoints. Context menus. 
 
In the XY view you can use the following context menu displayed by 
right-clicking the mouse over a crosspoint: 
 
 
 
 
 
 

 
For each crosspoint you can "Take" (activate or deactivate) or "Protect" it and also see the 
physical connections (input connected to output). The "Clear Selection" option will clear any 
selection of crosspoints on the XY view. 
 
In the case of crosspoints between Dante lines the "Vumeter" option 
appears enabled so you can open the precision vumeters 
corresponding to the input and output associated to that crosspoint. 
This option also appears for crosspoints between a Dante line (input 
or output) and analog or digital line (output or input), but in this case 
only the precision vumeter of the Dante line will appear. See section 
5.3.1 of this manual.  
 
 
 
In the case of NETBOX DSP the "Gain Control" option appears so 
you can adjust the crosspoint gain. See section 5.3.2 of this manual. 
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If you locate the mouse over the label of an input line, a right mouse 
click will open the following context menu:  
 

As you can see the "Gain Control" option has been added to the 
menu and has also changed the information concerning the physical 
connection - only indicating the name of the input/output line. The 
remainder actions are intact i.e., you can still execute the "Take" 
action or "Protect" the selected crosspoints or clear the selected 
crosspoints. 
 
 
 

If you locate the mouse over the label of an output 
line, a right mouse click will open the following 
context menu: 
 

As you can see the same options are shown and 3 
new actions appear. The first 2 ("Protect all CP to 
output" and "Unprotect all CP to output") allow to 
protect or unprotect all the established crosspoints 
towards that output. 
 
 
 
 
 
 
 
 

 

For both actions, confirmation is required: 
 

 
 
 
 
 
 
 
 
The "Tone" option allows to activate the routing of 
the test tone of 1KHz and +4dBu (-20dBFS) 
towards the output line. Confirmation is required: 
 
 
 
 
 
 
In case that this routing is already active, the option appears as "Tone OFF" and allows to 
deactivate it. Confirmation is also required. 

 
In case that input or output line is a Dante line the "Vumeter" option 
also appears enabled so you can open the associated precision 
vumeter. See section 5.3.1 of this manual. 
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In the case of NETBOX DSP, the context menu associated to input or 
output lines includes also the "Processes" option. See section 5.3.3 
of this manual. 
 
 
 

 
 
 

 
 
 
 
 

 
5.3.1. Precision vumeters. 
 
As indicated in the previous section, the "Vumeter" option allows you to open the precision 
vumeter corresponding to the selected Dante input or output line. This option also appears 
enabled in the case of crosspoints where at least one of the lines is a Dante line. 
 
Those vumeters look like this: 
 

 
  

The upper part of the window indicates whether it's an input 
(I) or output line (O). Next, the line name is displayed. In the 
example, the first vumeter corresponds to the mono input line 
"IP 13 L" and the second one to the stereo output line "IP 02 
ST". 
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5.3.2. Gain control. 
 
As indicated in section 5.3, the "Gain Control" option allows you to set the individual gain for 
each of the NETBOX inputs, outputs and, only in the case of NEBOX DSP, crosspoints. The 
adjustments is accomplished by selecting the "Gain Control" in the contextual menu and then 
acting on the gain with the Fader tool that will pop-up. Digital gain adjustment is from -infinite to 
+12dB. It's also possible to inverse the phase of the signal if so required. 
 

The gain of an input or output line can be adjusted even if these are not part of a crosspoint. 
 

In the case of analog and digital inputs and 
outputs (NETBOX 32/8 AD MX) and crosspoints 
(NETBOX DSP), the adjustment looks like this: 
 
 
 
 
 
 
 
In the case of stereo lines the gain of each 
channel can be configured separately. In the lower 
part of this window 3 buttons are shown: 
 

allows to align the R channel level with 
the L channel level. 
 

allows to link (or not) both channels in 
order to have (or not) a synchronous 
movement of both faders. 
 

allows to align the L channel level with 
the R channel level. 

 
 
 
 
 

In the case of AoIP inputs and 
outputs, the adjustment looks like 
this: 
 
 
 
In this case you can configure 
manually the gain (default option) or 
establish an Automatic Gain 
Control (by activating the "AGC 
Enabled" tic-box). 
 
By default, AGC is configured as        
-20dBFs. 
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 In the case of stereo AoIP inputs 
and outputs, the adjustment looks 
like this: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5.3.3. Processes. 
 
As indicated in section 
5.3, only in the case of 
NETBOX DSP, the 
context menu displayed 
by right-clicking the 
mouse over an input or 
output line includes also 
the "Processes" option. 
 
 
 
 
 
 
 
 
 

 
When you select this option the following window will 
appear. 
 
In the upper part of the window the short name of the 
line is shown as well as it's mono or stereo. 
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Next the available types of processes are shown (for more information, please consult section 

6.6 of this manual). In order to activate a process just press the associated  button and, in the 
window that appears, configure the parameters associated to the selected process (or select 
one of the presets previously configured by double-clicking one of them in the list on the right) 
and then select the "Enabled" option: 
 

 
 

In the example, we press the  button of "FILTER" option, then select preset 2 ("HP2") and 

 

activate it by means of the button  
 
 

From this window, you can also create, delete and modify presets, by 
means of the buttons that appear up on the right. The first one allows to 
save configuration into a new preset, the second one allows to overwrite 
the selected preset (confirmation is required) and the third one allows to delete the selected 
preset (confirmation is also required). 
 

When the window is closed by means of the  
button, the activation of that filter is shown in the 
"Processes" window: 
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You can activate several processes in the same line. It 
will be reflected the same way in the "Processes" 
window. 

 

An active process can be edited by means of the  

button or deactivated by means of the  button.  
 

 
 
 
 
 
 
 
 
 

On the other hand, in the XY view the 
label of the input or output lines 
where a process has been activated 
shows a yellow indicator of active 
process: 
 

   
 

 
 
 
 

Besides, in the upper bar of the application, the DSP module percentage of use is shown. 
 

 
 

 
6. DROP-DOWN MENU: Config. 
 
The options that are available in the "Config" drop-down 
menu are described in the following sections. 
 
The "Processes" option is available only for NETBOX 
DSP. 
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6.1. Netbox List. 
 
The first thing that needs to be accomplished once the "Netbox RTC" application has been 
installed, is to connect to the NETBOX that you want to control and operate. To do so, click on 
"Config" drop-down menu and select the "Netbox List" option. 
 
The following window will open to the left: 

 
Firstly you must press the button with the Earth icon 
("Select Local IP") in order to select the IP address 
corresponding to the PC where the application is installed. 
 

When you press this button a window will open that 
reflects several IP addresses, if you have configured our 
Network Interface or NIC with several IP addresses in 
different ranges. 
 

When you select the IP address that would be appropriate 
and in the same range as the device that you want to 
control with the application and confirm the selection by 
clicking on the "OK" button, that IP address will be shown 
in the previous button. 
 
 

 

      
 
Below the "Local IP" button you will find the title "Netbox List" and immediately below this four 
buttons: 
 

 Allows to add a new NETBOX device to the "Netbox 
LIst". You must select the model (NETBOX 8, NETBOX 32 
or NETBOX DSP), type in the IP Address of the device 
and give a name to it. 
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 Allows to edit the selected device. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 Allows to delete the selected device from the 
"Netbox List". The user will be prompted to confirm 
the deletion. All the device data will be lost 
(including salvos, macros, schedules...). 
 
 
 
 
 

 Allows to connect to the selected device. When the control computer NIC and the 
device are in the same range of IP addresses, the unit will connect to the control software, 
server application and database and signal to the software that the connection is established. At 
the footer of the "NetboxRTC" application the 
NETBOX device that is connected is indicated. 
 

When there is no connection to the selected device 
it appears in red. 
 

 The previous button changes to "Disconnect" and allows to disconnect the 
selected NETBOX device in order to select another one and connect to it. 
 
If you connect to a device without the 
corresponding license activated (see section 2.1 of 
this manual), an informative screen will appear 
when you try to access to any of the other options 
of the drop-down menus. 
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6.2. Users. 
 
The "NetboxRTC" application 
provides different levels of users to 
be implemented to control the 
NETBOX matrix. There are three 
levels of operators or users: 
Administrator, Supervisor and 
Controller. 
 
 
 

When clicking on the  button you are opening the "ADD USER" dialogue/edit box: 
 
You can now provide the "Name" of 
the user, the "Login" name and a 
"Password". Also, you can decide 
the level of the user to the right of 
these fields and as indicated above. 
When the creation of the new user 

has concluded you click on  

to confirm or  to abort the 
adding of the new user. 
 
 
 
 
 

 
 
 
 

The  button will open the "EDIT USER" dialog/edit box, identical to the previous one: 
 
You can now edit the "Name" of the 
user, the "Login" name and modify 
the "Password". Also, you can 
change the level of the user to the 
right of these fields and as indicated 
above. When the editing has 

concluded you click on  to 

confirm or  to abort the 
editing the user. 
 
 
 
 
 
 
 
 
 

If you select a user and click on the  button you will be prompted to confirm that you want to 
delete the user selected: 
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Press "Yes" to proceed or "Cancel" to abort the deletion of the user. 
 
There are three levels of users: Administrator, Supervisor and Controller. 
 
All actions are allowed for Administrators. Supervisors and Controllers have restricted access to 
certain menus or actions, that are shown in the following table: 

 
Menu - Action Supervisor Controller 

File   

         New Logical XY View   
                                           Customize   
                                           Salvo Override   
                                           Macro Override   
         New Vumeters View   

         Add Talkback   

         Status XY   

         All Connections View   
         Salvo to View   

         Close   

         Close All   

         Open Workspace   

         Edit Workspace   

         Save Workspace As...   
         Log - Macro & Salvo   

         Backup Database   
         Restore Database   
         Backup Matrix   
         Exit   
Config   

         Netbox List   

                                           Add / Edit / Delete   
                                           Local IP Configuration   
         Users   
         Salvos   
         Macros   
         Alarms   
         Processes   

         Talkback   
         Logical Lines   
         Virtual GPO   
         Virtual GPI   
         GPI   
         Clear, Save & Reset   
         HW Switch   
         Remote IP   
         Vumeters   
         Netbox - IP Server RTC   
Schedule   

         Schedule   

                                           Add / Edit / Run / Remove   
         Holiday Calendar   



 
 

AEQ NETBOX RTC 

 
 

55 

6.3. Salvos. 
 
A salvo is a configuration of crosspoints or connections between inputs and outputs, pre-
configured and that can be activated manually, through a schedule or through GPI’s triggered 
by remote or local equipment or devices. When you click on "Salvos" in the "Config" drop-down 
menu, the list of salvos window will open: 
 

 
 
The buttons available in the upper part of the list of salvos are the following: 
 

  allows you to close the window. 
 

  allows you to create a new salvo. 
 

  allows you to edit an existing salvo. 
 

  allows you to delete the selected salvo from the list. Confirmation is required. 
 

If no salvo has been created yet, the list will be empty. Click on the  button and the window 
for creating salvos will appear (this is the same window that will allow you to edit an existing 
salvo). From the upper left part of the window from left to right and going downwards, the 
following fields and controls are available: 
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 allows you to close the "NEW SALVO" / "EDIT SALVO" window. 
 

Below this area, the salvo information area will appear: 
 

- "NEW SALVO" or "EDIT SALVO" field indicates if you are creating a new salvo or editing 
an existing one. 

- "Name": field used to name the salvo alphanumerically. 
- "Description": field allowing us to provide a brief description of the salvo. 
- "Request Confirmation": this tic-box should be activated when you want any user to 

confirm the activation of a salvo. This will treat the salvo as critical and will prompt the user 
to confirm the activation or deactivation. 

 

 allows you to confirm the creation or edition of the salvo and save it to the database. 
 

 allows you to discard the creation or edition of the salvo to the database. 
 

Following the salvo information the "Salvo Content" area will appear: 
 

 allows you to remove the crosspoint action from the salvo. 
 

 allows you to move the crosspoint action up in the sequence of the salvo. 
 

 allows you to move the crosspoint action down in the sequence of the salvo. 
 

Below these buttons the following columns will also appear: 
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- "IdOrder": order of the action in the salvo. 
- "Input Line": short name of the input line of the crosspoint. 
- "Output Line": short name of the output line of the crosspoint. 
- "Connect": type of connection: if green this means the action is to connect or generate the 

crosspoint; if red this means that the crosspoint will be deactivated or disconnected. 
- "Protect": you can determine if a crosspoint action in the salvo should be protected from 

deactivation by locking or protecting this. This is shown with a closed padlock. If the salvo 
action includes the unprotect of this crosspoint, this is shown with an open padlock. 

 
To the right of the "Salvo Content" area you will find the "Available Logic Lines" that you can use 
for matrix crosspoints. The upper part of this section contains the input lines and the lower part 
the output lines. The list of input and output lines is organised in three columns with the 
following headings: "Short Name" of the input/output line, "Description" and "Stereo" (indicates 
with a stereo symbol if the line has been configured as stereo). 
 
Between these sections, the possible crosspoint actions are located: 
 

 

Allows you to add the salvo action for the crosspoint between the selected 
input line and output line. The different options for the action are: 

 

Connects the input line to the output line selected. 
 

Disconnects the input line from the output line selected. 
 
Marks the crosspoint as protected. 
 

Un-marks the crosspoint as protected. 
 

Will make no change in regards to the protection of the crosspoint. 
 

 

In the example we have made a crosspoint (connection) between the "A 02 L" input line  and 
the "IP 01 L" AoIP output line (no change in regards to the protection of this crosspoint will be 
taken when you execute the salvo), a disconnection and unprotect of the crosspoint between 
the "A 05 L" input line  and the "D 02 L" output line and a connection and protect of the 
crosspoint between the "A 03 R" input line  and the "A 08 R" output line. 
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6.4. Macros. 
 
A macro is an action or a set of several actions that can include already generated salvos, 
activation or deactivation of independent crosspoints or the resulting combination of both, and 
the configuration of GPO’s that can trigger specific actions related to external equipment or 
devices. A macro is a very useful tool when using the scheduler and when automating a matrix 
operation. When you click on "Macros" in the "Config" drop-down menu, the list of macros 
window will open: 
 

 
 
The buttons available in the upper part of the list of macros are the following: 
 

  allows you to close the window. 
 

  allows you to create a new macro. 
 

  allows you to edit an existing macro. 
 

  allows you to delete the selected macro from the list. Confirmation is required. 
 

If no salvo has been created yet, the list will be empty. Click on the  button and the window 
for creating macros will appear (this is the same window that will allow you to edit an existing 
macro). From the upper left part of the window from left to right and going downwards, the 
following fields and controls are available: 
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 allows you to close the "NEW MACRO" / "EDIT MACRO" window. 
 

Below this area, the macro information area will appear: 
 

- "NEW MACRO" or "EDIT MACRO" field indicates if you are creating a new macro or editing 
an existing one. 

- "Name": field used to name the macro alphanumerically. 
- "Description": field allowing us to provide a brief description of the macro. 
- "Request Confirmation": this tic-box should be activated when you want any user to 

confirm the activation of a macro. This will treat the macro as critical and will prompt the 
user to confirm the activation or deactivation. 

 

 allows you to confirm the creation or edition of the macro and save it to the database. 
 

 allows you to discard the creation or edition of the macro to the database. 
 

Following the macro information the "Macro Content" area will appear: 
 

 allows you to remove the action from the macro actions list. 
 

 allows you to move the action up in the sequence of the macro. 
 

 allows you to move the action down in the sequence of the macro. 
 

Below these buttons the following columns will also appear: 
 

- "IdType": identifies what type of action the event in the macro is: crosspoint, salvo or GPO. 
- "Description": indicates the name of the action, whether is a crosspoint, a salvo or a GPO. 
- "Property": provides information regarding the action in the macro - for example the release 

of a salvo, the connection or disconnection of input and output lines to conform a crosspoint 
or the activation or deactivation of a GPO. 
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6.4.1. Programming a crosspoint in a macro. 
 
To the right of the "Macro Content" area you will find the "Available Actions" field and three 
options: "Crosspoint", "Salvo" and "GPO Activation". If you select "Crosspoint", immediately 
below this field the "Available Logic Lines" that you can use for matrix crosspoints will appear. 
The upper part of this section contains the input lines and the lower part the output lines. The 
list of input and output lines is organised in three columns with the following headings: "Short 
Name" of the input/output line, "Description" and "Stereo" (indicates with a stereo symbol if the 
line has been configured as stereo). 
 
Between these sections, the possible crosspoint actions are located: 
 

Allows you to add the macro action for the crosspoint between the selected 
input line and output line. The different options for the action are: 
 

 

Connects the input line to the output line selected. 
 

Disconnects the input line from the output line selected. 
 

 

Marks the crosspoint as protected. 
 

Un-marks the crosspoint as protected. 
 

Will make no change in regards to the protection of the crosspoint. 
 

 

6.4.2. Programming a salvo in a macro. 
 
If you select "Salvo" in the "Available Actions" field, the "Select Salvo" dialogue box will appear: 

 

The  button allows you to add 
the selected salvo from the "Select Salvo" 
drop-down list. 
 
"Select Salvo" drop-down list will show the existing, already created salvos in a list that the user 
can select from. The "State" field has two options: "Take" or "Release",. i.e. to take the complete 
salvo in the list of actions defined in the macro or release the selected salvo in the list of actions 
defined in the macro. 

 
6.4.3. Programming a GPO in a macro. 
 
If you select "GPO Activation" in the "Available Actions" field, the "Select  GPO" dialogue box 
will appear:  
 

The  button allows you to add 
the selected GPO from the "Select GPO" 
drop-down list.  
 
"Select GPO" drop-down list will show the existing GPO’s in a list that the user can select from. 
The "State" field has two options: "On" or "Off", i.e. the GPO will generate an On for the GPO 
contact or address in the list of actions defined in the macro or to turn the GPO Off in the list of 
actions defined in the macro. 
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6.5. Alarms. 
 
The "Alarms" option of the "Config" drop-down menu allows to configure system alarms that will 
be activated when there is no signal in a line or when that signal returns. When you select this 
option the following window will appear: 
 

 
 
The buttons available in the upper part of the window are the following: 
 

  allows you to close the window. 
 

  allows you to create a new alarm. 
 

  allows you to edit an existing alarm. 
 

  allows you to delete the selected alarm from the list. Confirmation is required. 
 

If no alarm has been created yet, the list will be empty. Click on the  button and the window 
for creating alarms will appear (this is the same window that will allow you to edit an existing 
alarm). 
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The available fields are the following: 
 

- "Name": field used to name the alarm alphanumerically. 
- "Description": field allowing us to provide a brief description of the alarm. 
- "On Conflict": allows you to choose what to do in case of conflict (when there are protected 

crosspoint). You can select a "Normal" execution or an "Overwrite" (make an execution 
opening the pad-locks). 

- "Fire when audio below": drop-down field that allows you to choose when the alarm will be 
fired depending on the level in dBFS of the selected line audio. There are 3 options with 3 
associated colors: 
 

• Grey: less than -60dBFS  

• Green: between -60 and -20dBFS  

• Yellow: between -20 and -6dBFS  
 

NOTE: 0dBFS = +24dBu  
 

- "Enabled alarm": this tic-box allows 
the user to choose whether the alarm 
is initially enabled or not. 

- "Line Alarm": this filed shows the line 
the alarm is applied to. It indicates if 
it's an input or output line, as well as 
the line short name and description. 

 

- "On event fired": allows you to select 
the macro that will be executed on 
alarm fired and the wait time after the 
detection of the signal absence (the 
defined time will be increased by 2 
seconds, as the absence of a signal 
on a line for less than 2 seconds 
should not be a reason to generate an 
alarm). 

 

- "On event finished": allows you to 
select the macro that will be executed 
when alarm finishes and the wait time 
after the detection of the signal return. 

 
 
 
 
In the lower part of this window you will find the list of input and output logical lines that are 
available in order to select the line the alarm will be associate to, by means of the "Select Line 
IN" or "Select Line OUT" button. 
 

The  button, located in the upper right corner, allows you to confirm the creation or edition 
of the alarm and save it to the database. 
 

The  button allows you to discard the creation or edition of the alarm. 
 
In the upper bar of the application, beside a red bell icon, the number of active alarms is shown 
(this indication will appear only when the "Netbox Server" application is running). 
 

 
 
When you press this indication a window will open that shows the list of defined alarms as well 
as the status and information about them. Here you can activate or deactivate any alarm at any 
time. 
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In this window the following columns appear: 
 

- "Id": alarm numerical identifier. 
- "Enabled": indicates whether the alarm is enabled or not. 
- "Alarm": indicate whether the alarm is fired or not. 
- "Name": alarm name. 
- "Level": indicates the configured level for the alarm to fire. 
- "Type": indicates if the associated line is an input or an output. 
- "Line Name": indicates the short name of the associated line. 
- "Macro Begin ": indicates the macro that will be executed when the alarm is fired. 
- "Macro End": indicates the macro that will be executed when the alarm is finished. 
 

The  button allows you to deactivate the selected alarm that changes to: 
 

 
 

The  button allows you to reactivate the alarm. 

 
On the other hand, in the case of NETBOX DSP a second indicator of hardware alarms appears 
(this is independent of the "Netbox Server" application). When you press this indication a list will 
be unfolded that shows if there is any active hardware alarm in the unit: 
 

 
 

The available alarms are: 
 

- "Power supply 1": indicates that the main power supply is not present or fed or that it's 
damaged. 

- "Power supply 2": indicates that the redundant power supply is not present or fed or that 
it's damaged. 

- "Link Lan Eth AoIP 1": indicates that there is no connection in Ethernet LAN 1 port. 
- "Link Lan Eth AoIP 2": indicates that there is no connection in Ethernet LAN 2 port. 
- "Temperature": indicates that the unit is overheated. 
- "Fan": indicates that the unit has reached the operating temperature that should starts the 

cooling fan but it didn't start because of being damaged or blocked. 
- "HW not configured": indicate that the FPGA is not configured or it's resetting. 
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6.6. Processes. 
 
The "Processes" option of the "Config" drop-down menu allows to create presets of the 
different processes types available in the system. This option is available only for NETBOX 
DSP. 
 

Processes can be applied to a maximum of 64 selectable lines. These are the available 
processes: 
 

• "Equalizer": Four-band parametric equalizer. 

• "Filter": High pass, low pass and band pass filter. 

• "DLP" (Dynamic Level Processor): 5-points compressor-limiter-expander. 

• "Noise Gate". 

• "Delay". 
 

You can access to processes 
configuration through the drop-
down menu that appears when the 
"Processes" option of the "Config" 
menu is selected: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

When clicking on one of the options, its presets editing window is presented, where these 
presets can be created, deleted or modified. If no preset has been created yet, the list will be 
empty. 
 

 
 

As an example, here you can see the equalizer selection window, where new presets can be 

created by means of the  button, deleted by means of the  button or edited by means of 

the  button. 
 

Next, the adjustment windows for each of the different processes are described. 
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Equalizer. 
 
A four-band parametric equalizer is available. 
 

 
 
An identifier name is typed in the "NAME" field. Afterwards, the adjustment of parameters for 
each of the four bands is performed:  

 

• "FREQ": Band’s center frequency in a range from 10Hz to 20KHz. 

• "Q": Quality factor of the band, adjustable from 0.1 to 20. 

• "GAIN": Band’s gain, in a range from -18dB to +18dB. 
 

Once edition is finished, click on the  button to validate the changes or click on the 

 button to discard the changes. After confirmation, the edition window will close and the 
new preset will appear in the list. 
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Filter. 
 
Low-pass and/or high-pass filter can be activated for the input, so only the desired range of 
frequencies passes to the system.  
 

 
 
As for the rest of processes, an identifier name is given to the preset, and then its parameters 
are set. These are the parameters applicable for filters: 
 

• "HIGH PASS": High-pass filter adjustments. 
 

o "FREQ": High-pass filter cutoff frequency, from 20Hz to 1KHz. 
o "On/Off": Activate or deactivate high-pass filter. 

 
 

• "LOW PASS": Low-pass filter adjustments. 
 

o "FREQ": Low-pass filter cutoff frequency, from 1KHz to 20KHz. 
o "On/Off": Activate or deactivate low-pass filter. 

 

Once edition is finished, click on the  button to validate the changes or click on the 

 button to discard the changes. After confirmation, the edition window will close and the 
new preset will appear in the list. 
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DLP (Dynamic Level Processor). 
 
This window allows for the creation of a DLP (Dynamic Level Processor) adjustment preset, 
basing on compression and expansion, creating up to five points as required to control the voice 
dynamics. 
 

 
 
As for the rest of processes, an identifier name is given to the preset, and then its parameters 
are set. 
 

This option allows you to define up to 4 configurable sections for OUT/IN transfer function, each 
one of them working as compressor/expander or limiter with different ratios. 
 

The graph shows the variation produced at the different levels of the signal. The input levels are 
plotted along the horizontal axis, while the output levels obtained are plotted along the vertical 
axis. 
 

You can add up to 5 points to that graph (from “Points” box) in order to define up to 4 
processing sections. By selecting and moving each one of those points you can modify the 
different compression ratios. You can also configure attack and release times. 
 

Proper DLP configuration demands training and experience, and is beyond the scope of this 
manual. 
 

Once edition is finished, click on the  button to validate the changes or click on the 

 button to discard the changes. After confirmation, the edition window will close and the 
new preset will appear in the list. 
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Noise Gate. 
 
Noise gate is a special dynamics processor that attenuates or completely mutes audio below a 
certain level. 
 

 
 
A name has to be assigned to each preset, which can be configured afterwards. 
 
The parameters to adjust for a noise gate are as follows: 
 

• "THRESHOLD": Nominal level below which the noise gate starts operating. 

• "ATTACK": Attack time. The time it takes to start operating. 

• "RELEASE": Release time, this is the time that the adjustment still operates for after 
receiving a sound impulse. 

• "HOLD": Time that the effects still doesn’t operate for, even in presence of a silence. 

• "RANGE": Number of dB that the sound is attenuated when the processor is operating. 
 

Once edition is finished, click on the  button to validate the changes or click on the 

 button to discard the changes. After confirmation, the edition window will close and the 
new preset will appear in the list. 
 
 
Delay. 
 
This process is a time delay of a signal. 
 
In this case, an identifier name is also given to the preset, and then configure its only parameter 
("Delay time") that allows to adjust the delay time in milliseconds. 
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Once edition is finished, click on the  button to validate the changes or click on the 

 button to discard the changes. After confirmation, the edition window will close and the 
new preset will appear in the list. 
 
 
Once the required presets are created, they will be available in the system and will appear when 
you try to activate a process in any of the input lines. From that window you can also create, 
delete and modify presets. See section 5.3.3 of this manual. 
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6.7. Talkback. 
 
A "Talkback" group is a combination of input and output lines that allows to automatically 
execute a n-1 routing between those lines (additionally, the existing crosspoints towards the 
outputs lines are deleted and, in the case of a NETBOX DSP, the gains of all the crosspoints, 
activated or not, towards those inputs are restored to 0). When you click on "Talkback" option in 
the "Config" drop-down menu, the list of "Talkback" groups window will open, where they can be 
created, edited or deleted: 
 

 
 
The buttons available in the upper part of the list of "Talkback" groups are the following: 
 

  allows you to close the window. 
 

  allows you to create a new "Talkback". 
 

  allows you to edit an existing "Talkback". 
 

  allows you to delete the selected "Talkback" from the list. Confirmation is required. 
 

If no "Talkback" has been created yet, the list will be empty. Click on the  button and the 
window for creating "Talkback" will appear (this is the same window that will allow you to edit an 
existing "Talkback"). From the upper left part of the window from left to right and going 
downwards, the following fields and controls are available: 
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 allows you to close the "NEW TALKBACK" / "EDIT TALKBACK" window. 
 

Below this area, the "Talkback" information area will appear: 
 

- "NEW TALKBACK" or "EDIT TALKBACK" field indicates if you are creating a new 
"Talkback" or editing an existing one. 

- "Name": field used to name the "Talkback" alphanumerically. 
- "Description": field allowing us to provide a brief description of the "Talkback". 
- "Input Orders": field allowing us to select the input line that will work as "Order" input. 
- "Output PFL": field allowing us to select the output line that will work as "PFL" output. 
- "Talk All": when the "Enabled" option is selected, the "TALK ALL MIC TB" button will be 

shown in the "Talkback" window. When the "Disabled" option is selected, that button will not 
appear. See section 4.3 of this manual. 

- "Talkback Mode": when the "Mute" option is selected and a "TALK" button of the 
"Talkback" window is pressed, all the crosspoints connected to the associated output line 
are deactivated and the "Order" input is sent to it. When the "Attenuation 20 dB" is selected, 
those crosspoints will remain but with an attenuation of 20 dB. This option is available only 
for NETBOX DSP. See section 4.3 of this manual. 

- "Mute in Program": when the "Enabled" option is selected, the "MUTE OFF" button will be 
shown in the "Talkback" window. When the "Disabled" option is selected, that button will not 
appear. This option take effect when one of the lines selections of the "Talkback" is 
configured as "Program". See section 4.3 of this manual. 

 

 allows you to confirm the creation or edition of the "Talkback" and save it to the 
database. 
 

 allows you to discard the creation or edition of the "Talkback" to the database. 
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Following the "Talkback" information the "Talkback Content" area will appear: 
 

 allows you to move the selected line up in the sequence. 
 

 allows you to move the selected line down in the sequence. 
 

 allows you to open the selection of the lines that will be included in the "Talkback" (in the 
"Properties" area). 
 

 allows you to edit the selected line. 
 

 allows you to remove the selected line. 
 

 allows you to configure the selected line as "Program". 
 

 

Below these buttons the following columns will also appear: 
 

- "Order": order of the line in the "Talkback". 
- "PFL - In": input line that will be sent to the "PFL" output when the associated "PFL" button 

of the "Talkback" window is pressed. 
- "Mute - In": input line that will be muted when the associated "MUTE OFF" button of the 

"Talkback" window is pressed (all the crosspoints that send that line towards the defined 
"Talk" outputs are deleted). 

- "Talk - Out": "Talk" output line associated to the previous input lines. 
- "Program": indicates if the lines selection is configured as "Program", in which case, it will 

be shown in a different way in the "Talkback" window (see section 4.3 of this manual). 
 

When the  button of the "Talkback Content" area is 
pressed, the following buttons will appear in the "Properties" 
area allowing us to select the lines that will be included in the 
"Talkback": 
 

 
 
 
 
 
 
 
 
 
 
 
 

 

When you press the  button of each one of the three sections a window will open that 
allows us to select the output line that will appear in the "Talk - Out" column, the input line that 
will appear in the "Mute - In" column and the input line that will appear in the "PFL - In" column. 
By default, when the "Mute" input is selected the "PFL" input is automatically configured with the 
same input line, although you can change this selection by pressing the associated button. In 
order to add the lines selection to the "Talkback" just press the "Update" button. 
 

NOTE: An output line selected as "Talk" can be 
repeated in a "Talkback" group. n that case an 
informative window will appear: 
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In the example, a "Talkback" group (TB 01) is being created where the "IP 07 ST" input line is 
defined as "Order" input and the "IP 07 ST" output is defines as "PFL" output. Besides, three 
combinations of input and output lines are defined (the second one is configured as "Program") 
and a fourth one is being added where the "IP 04 ST" output line is selected as "Talk" output 
and the "IP 05 ST" input line is selected as "Mute" and "PFL" inputs. 
 

 
 
When you press the "Update" button the new lines combination will appear in the "Talkback 
Content" area: 
 

 
 
Once you have finished the "OK" button should be pressed to save the "Talkback" to the 
database. 
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6.8. Logical Lines. 
 
The "Logical Lines" option of the "Config" menu gives access to the area of the application 
where you can edit the physical or logical input and output lines of the NETBOX in regards to 
their "Short Name" and "Description". Here you can also make or break "Stereo" pairs, choose 
the color you want to visualize the vumeters frames (only for Dante lines; it's also reflected in 
the XY view) and define if the output line will be summable or not. 
 
NOTE: The "Dante" option of the "Config" menu allows you to rename the transmission and 
reception channels of the unit's Dante module with the names of the associated logical lines 
defined here (see section 6.13 of this manual). 
 

 
 
Input lines are listed to the left side and the output lines to the right. 
 

Apart from the  button to cancel or exit, there is an edit button located in the header 
of the lists  - the number of inputs and their generic names are imported by the 
application automatically when a connection to the NETBOX is established. There is also 
a button that allows you to generate/select an import file in order to modify the labels 
associated to each line ("Short Name" and "Description") from a text file. 
 
The "Id" and "Name Id" columns are 2 informative fields, that can't be modified and show the 
line identifier number and the line internal name. 
 

If you click on the  button on either the input or the output side of the lines, an edit dialogue 
box will open above the listed lines and that allows us to change the "Short 
Name", "Description" and grouping and ungrouping the lines in Stereo 
pairs ("Mono" or "Stereo"). In the case of the Dante lines you can also 
choose the color of the vumeters frames (it's also reflected in the label of 
the line in the XY view) and in the case of the output lines if the line will be 
summable or not. 
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It also allows the user to confirm the edit and move to the prior or next line in the list without 
leaving this dialogue box which becomes very handy when setting up the system for the first 
time. 
 
The following examples show a digital input line configured as mono, an analog output line 
configured as stereo and summable, a Dante input line configured as stereo and with blue 
vumeters frames and a Dante output line configured as mono, non summable and with red 
vumeters frames. 
 

 
 

 
 

Once you have finished the editing you confirm the changes with the  button or not with 

the  button, both of which will close the "EDIT LINE" dialogue box. The changes will be 
automatically updated to the list. 
 

If you use the button  or  instead of the  button, you will also confirm 
the changes and go to edit the next or previous line respectively. 
 

When done editing, you exit the logical lines edit by clicking on the  button in the upper left 
corner. 
 
 
In the case of NETBOX DSP, when you try to change from mono to stereo (or vice versa) an 
input or output line where one or several processes have been activated, you must first disable 
these processes in order to be able to make that change. In that case an informative window 
will appear: 
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If you click on the  button on either the input or the output side of the lines, a window will 
open that allows us to generate or select an import file in order to modify the labels associated 
to each line from a text file: 
 

 
 
When there is no import file previously created, you must select the file location (by default 
C:\AEQ\NetboxRTC) and give it a name ("Inputs" in the example). 
 
When you press the "Open" button the file is created in the selected location and the following 
window will appear:  
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where the lines (input lines in the example) and the new labels are shown. In this case, given 
that we have just created the file, there is no content in the "-- New Name --" and "-- New 
Description --" columns and the lower part of the window indicates that no changes are detected 
in those labels: 
 

 

 

Since there are no changes, just press the  button to close that window. 
 
When you open the created "Inputs" file (using "Notepad" or "WordPad" for instance), it will look 
like this: 
 

 

 
There you can configure the desired "Short Name" or "Description" in the list that appears: 
 

   
 
In the example, we have modified the name and description of the first 4 input lines. 
 
The labels that are left blank will be ignored during the import process. 
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If you click again on the  button of input lines and you select the modified "Inputs" file in the 
window that appears, the following window will appear again when you press the "Open" button: 
 

 
 
where the 4 new names and descriptions are shown in the "-- New Name --" and "-- New 
Description --" columns and the lower part of the window indicates the detected changes: 
 

 
 

If you press now the  button, a confirmation window will appear: 
 

 
 
After confirmation, an informative window indicates that the "NetboxRTC" application must be 
restarted: 
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Once restarted, the updated list of input lines will appear: 
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6.9. Virtual GPO. 
 
The NETBOX devices are capable of generating a Virtual GPO command that is sent over the 
audio and control network. This command can be interpreted by any AEQ standard AoIP 
equipment and many third-party SW applications. This section allows us to prepare these GPO 
commands so that these can be used for, for example, macros and scheduled tasks when you 
need to command or automate the control of other equipment from the "NetboxRTC" 
application. What needs to be accomplished in this section is to set up these commands that 
are stored in the database of "NetboxRTC" and will be triggered by the NETBOX whenever so 
requested. 
 

 
 
For this you need to indicate the IP address that the GPO command is intended - addressed to, 
and the Id number of the GPO. Theoretically you could generate up to 256 GPO commands or 
Id Numbers for each and every IP address that you are able to communicate with. 
 

When clicking on the  or  button the 
"ADD Virtual GPO" or "EDIT Virtual GPO" 
dialogue box is opened: here you can indicate 
the "IP" address that the command is 
addressed for and the "Id Number" of the 
GPO command. 
 

 will confirm the creation or edition of 
the Virtual GPO and save this to the 
database. 
 

 will discard the creation or edition of 
the Virtual GPO. 
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6.10. Virtual GPI. 
 
The NETBOX devices are capable of receiving a Virtual GPI command that is sent over the 
audio and control network. This command can be generated by any AEQ standard AoIP 
equipment and many third-party SW applications. This section allows us to prepare these GPI 
commands so that these can be used to, for example, trigger macros or salvos when you need 
to automate the operation of the "NetboxRTC" application from external equipment or SW 
applications. What needs to be accomplished in this section is to set up these commands that 
are stored in the database of "NetboxRTC" and define what such commands should trigger in 
terms of macros or salvos will be triggered by the NETBOX whenever so requested. 
 

 
 
For this you need to indicate the Id 
number of the GPI. Theoretically you 
could receive up to 256 GPI commands 
or Id numbers from each and every IP 
address that are able to communicate 
with the NETBOX. 
 

When clicking on the  or  button 
the "ADD Virtual GPI" or "EDIT Virtual 
GPI" dialogue box is opened: here you 
can indicate the "Id Number" of the 
expected GPI and if the "State" expected 
should be interpreting the GPI as "On" or 
"Off". Next, there are two buttons that 
defines whether the GPI is going to 
trigger a salvo or a macro. 
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If you click on the "Salvo" button, the selection of salvo and the action definition ("Take" or 
"Release") appear. When you click on the salvo selection, the list of existing salvos will open to 
the right: 
 

 
 
If you select a salvo on the list and double click this it will confirm the selection. The other way 

to confirm the selection is by clicking the  button. This will confirm the triggering of the 
selected salvo when receiving the Virtual GPI with the corresponding Id Number and save the 
information to the system database. 
 

If you press the  button, this will discard the selection of the salvo and the association to 
the Virtual GPI Id Number. 
 
 
If you click on the "Macro" button, the selection of macro appears. When you click on the macro 
selection, the list of existing macros will open to the right: 
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If you select a macro on the list and double click this it will confirm the selection. The other way 

to confirm the selection is by clicking the  button. This will confirm the triggering of the 
selected macro when receiving the Virtual GPI with the corresponding Id Number and save the 
information to the system database. 
 

If you press the  button, this will discard the selection of the macro and the association 
to the Virtual GPI Id Number. 
 
Once you have finished editing the 
Virtual GPI Id Number and the 
associated action (macro or salvo) will be 
shown in the list of defined Virtual GPI’s: 
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6.11. GPI. 
 
The NETBOX 32 AD MX and NETBOX 8 AD MX have 16 and 4 physical opto-coupled GPI/O’s 
respectively. This section allows the user 
of "NetboxRTC" to define what physical 
GPI corresponds to a specific salvo or 
macro, i.e. if an equipment or device that 
is physically connected to the GPI’s of 
the NETBOX and this device sends a 
GPO signal with the Id of the GPI and the 
status "On" or "Off", the NETBOX will be 
able to interpret this and signal to the 
"NetboxRTC" application of what 
changes in the matrix needs to be 
accomplished. 
 

When clicking on the  or  button the "ADD GPI" or "EDIT GPI" dialogue box is opened: 
here you can indicate the "Id Number" of the expected GPI and if the "State" expected should 
be interpreting the GPI as "On" or "Off". Next, there are two buttons that defines whether the 
GPI is going to trigger a salvo or a macro. 
 

 
 
If you click on the "Salvo" button, the selection of salvo and the action definition ("Take" or 
"Release") appear. When you click on the salvo selection, the list of existing salvos will open to 
the right. 
 
If you select a salvo on the list and double click this it will confirm the selection. The other way 

to confirm the selection is by clicking the  button. This will confirm the triggering of the 
selected salvo when receiving the GPI with the corresponding Id Number and save the 
information to the system database. 
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If you press the  button, this will discard the selection of the salvo and the association to 
the GPI Id Number. 
 
If you click on the "Macro" button, the selection of macro appears. When you click on the macro 
selection, the list of existing macros will open to the right: 
 

 
 
If you select a macro on the list and double click this it will confirm the selection. The other way 

to confirm the selection is by clicking the  button. This will confirm the triggering of the 
selected macro when receiving the GPI with the corresponding Id Number and save the 
information to the system database. 
 

If you press the  button, this will discard the selection of the macro and the association 
to the GPI Id Number. 
 
Once you have finished editing the GPI 
Id Number and the associated action 
(macro or salvo) will be shown in the list 
of defined GPI’s: 
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6.12. Clear, Save & Reset. 
 
This option of the "Config" menu will open the following window to the left of the current XY view 
or layout: 
 

 
 
The buttons in each of the "Save", "Reset" and "Clear" sections are explained hereunder. 
 

The NETBOX have a memory bank to store a "Master Layout" of the 
matrix that includes all data concerning crosspoints and gains. The 
"Layout" button of the "Save" section will save the current layout of the 

resulting matrix to this part of the non-volatile memory of the NETBOX. 
 
 

The "Reset" button of the "Reset" section will reset the NETBOX. The unit 
will in this case startup with the last saved layout stored to its non-volatile 
memory. Take into account that this is not the "Master Layout" that is 

stored in a specific part of the NETBOX memory. 
 

The "Reset & Load Layout" button of the "Reset" section will reset the 
NETBOX and load the last stored "Master Layout" from the non-volatile 
memory of the NETBOX.  

 

The "Crosspoints" button of the "Clear" section will clear all the existing 
crosspoints and protections in the NETBOX Matrix.  
 

The "Crosspoints Gain" button of the "Clear" section will clear all the 
existing crosspoint gains in the NETBOX Matrix. This option is available 
only for NETBOX DSP. 

 

The "Inputs Gain" button of the "Clear" section will clear all the existing 
input lines gain that have been set in the NETBOX Matrix. 

 
The "Outputs Gain" button of the "Clear" section will clear all the existing 
output lines gain that have been set in the NETBOX Matrix. 

 

The "Inputs AGC" button of the "Clear" section will deactivate all the AGCs 
(Automatic Gain Control) of the input lines with that option activated. 
Additionally, AGCs are preconfigured as -20dBFs (default value). 
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The "Outputs AGC" button of the "Clear" section will deactivate all the 
AGCs (Automatic Gain Control) of the output lines with that option 
activated. Additionally, AGCs are preconfigured as -20dBFs (default 
value). 

 

The "Processes" button of the "Clear" section will clear all the processes of 
the input and output lines with configured processes. This option is 
available only for NETBOX DSP. 

 

The "HW Switch" button of the "Clear" section will clear all the HW Switch 
configurations that have been stored on the NETBOX. 
 

 

For all these actions the user will be prompted to confirm the operation. 

 
6.13. Dante. 
 
This option of the "Config" menu allows you to configure the Dante module of the unit (1 in the 
case of NETBOX 32/8 AD MX and up to 4 in the case of NETBOX DSP) with the device name 
defined in the "NetboxRTC" application (see section 2.5 of this manual). 
 

It also allows you to rename the transmission and reception channels of the Dante module with 
the names of the associated lines defined in the "Logical Lines" option of the "Config" menu 
(see section 6.8 of this manual). If any line is configured as stereo, at Dante level the 2 
associated lines will be renamed with the L and R ending. 
 

Finally, this option also allows you to modify the clock configuration at Dante level, taking into 
account the way that the device's synchronization is configured at local level. 
 

When you select the "Dante" option, the following window appears: 
 

 
 

The first thing to do is configure the IP address of 
the Dante module in the "Dante IP" field and press 
the associated "Search" button. 
 
 
 

When connection to the Dante module is established, the previous window changes to: 
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IMPORTANT NOTE: If changes are made to the Dante module from the "Dante Controller" 
application (for example, its name is changed), we must close and open again this window in 
order to refresh the information. 
 

The button  allows to save in the database the IP address of the Dante 
module that has been configured so you don't need to write it every time you enter this window. 
If you close the window and open it again, the connection to the Dante module is established 
automatically. 
 

 
The "Netbox Name" field shows the device name defined in the "NetboxRTC" application and 
the "Dante Name" field shows the name of the Dante module (if they don't match, the second 
one appears in red): 
 

   
 

 
In the central part of the window, the "Name", "Lines" and "Clock" tic-boxes allow you to select 
which changes you want to make to the Dante module: its name, the name of the Dante 
channels and/or the clock configuration. Once one or more of these tic-boxes is selected, the 
"Send" button is enabled, allowing the configuration to be sent to the Dante module. 
 

 
 
When you check the "Name" box and then press the "Send" button, the name of the Dante 
module (the one that appears in the "Dante Controller" application) is changed to the device 
name defined in "NetboxRTC" ("Netbox Name"): 
 

 
 
Once the change is made, the name is refreshed and no longer appears in red in the "Dante 
Name" field: 
 

 
 
When you check the "Lines" box and then press the "Send" button, the names of the 
transmission and reception channels of the Dante module (the ones that appear in the "Dante 
Controller" application) are changed to the names of the associated lines defined in 
"NetboxRTC": 
 

 
 
The "Reset Dante lines names" tic-box allows you to rename the transmission and reception 
channels of the Dante mode with the default names, as they leave the Factory, that is:  
 

          NBOX32_1L, NBOX32_1R, NBOX32_2L, etc. 
          NBOX8_1L, NBOX8_1R, NBOX8_2L, etc. 
          NBOXDSP_1L, NBOXDSP_1R, NBOXDSP_2L, etc. 
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In order to do that, just check that box (automatically, the "Lines" box is also checked) and press 
the "Send" button: 
 

 
 
 
In the upper right part of the window, the "External Sync" informative section appears, which 
shows the way that the device's synchronization is configured at local level: 
 

 
 
If you want to change that configuration, you must do it from the "AEQ NetBox Tool" application 
(see section 3.2.2.1 of the user's manual of the unit). 
 
Below this section, the information about the way that clock is configured at Dante level appears 
(and, at the right, the available Dante channels of the module): 
 

 
 
Depending the way the synchronization is configured at local level, the clock should be 
configured at Dante level, and vice versa (see section 4.7.4.3 of the AEQ AoIP user's manual). 
If configuration is correct, the information will appear as in the image above; if not, in the 
"Preferred Leader" and/or "Enable Sync To External" boxes the "Change" indication will 
appear in red and it will indicate the way that the associated box in "Dante Controller" should be 
(checked or not): 
 

 
 
In this example, the unit is configured as "Master" at local level and therefore the "Preferred 
Leader" and "Enable Sync To External" boxes should be checked in "Dante Controller", but they 
are not (so the "Change" indication appears). In order to change it, you can do it from the 
"Dante Controller" application or, if you prefer, from this window, by checking the "Clock" box 
and then pressing the "Send" button: 
 

 
 
The "Change" indication then disappears to indicate that configuration is now correct: 
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As previously indicated, in the case of NETBOX DSP, depending on the model, 1 Dante module 
(NETBOX DSP 64), 2 (NETBOX DSP 96), 3 (NETBOX DSP 128) or 4 (NETBOX DSP 160) will 
appear reflected. 
 
For instance, in the case of NETBOX DSP 128, the window accessed by the "Dante" option 
looks like this (after configuring the "Dante IP" field with the IP address of the main Dante 
module and pressing "Search"): 
 

 
 
As shown, in this case 3 lines appear that correspond to the 3 Dante modules installed in the 
unit. In order to access to all information, in the "Dante IP" field of lines 2 and 3 you should 
configure the IP address of the additional Dante modules and then press the associated 
"Search" buttons: 
 

 
 
The Dante channels associated with each module appear in the right column. 
 
In this case, if you want to modify any Dante parameter, for example the name of the modules, 
you can do it one by one, by checking the "Name" box and then pressing the "Send" button that 
gets active: 
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or change several at once, by checking the "Name" box of all the modules you want to rename 
and then pressing the new "Send All" button above: 
 

 

 
6.14. HW Switch. 
 
This option of the "Config" menu allows you to create configurations in order to activate 
crosspoints to a certain output line according to the status combination of up to 7 physical or 
virtual GPIs. 
 
That HW Switch configuration is stored on the NETBOX unit (in its non volatile memory) and no 
server is needed in order to execute it. 
 
You can create up to 20 HW Switch configurations per NETBOX, but keep in mind that when 
the output line is stereo the configuration counts double. Different inputs can be routed to each 
output depending on the switching of the configured GPIs. 
 
In this working mode, the outputs will always act as NON summable, so the last GPIs status will 
define which input is routed to the output. 
 
When virtual GPIs are used, the GPI number corresponds to the one configured in the " Virtual 
GPI to Physical GPO association" area of the "Remote IP" section of the "Config" menu: it won't 
be managed the way explained in the corresponding section of this manual but it will be used as 
GPI status for HW Switch. 
 
When you click on "HW Switch" option in the "Config" drop-down menu, the list of defined HW 
Switches window will open (each one shows the associated output list): 
 

 
 
The buttons available in the upper part of the list are the following: 
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  allows you to close the window. 
 

  allows you to create a new HW Switch. 
 

  allows you to edit an existing HW Switch. 
 

  allows you to delete the selected HW Switch from the list. Confirmation is required. 
 

If no HW Switch has been created yet, the list will be empty. Click on the  button and the 
window for creating HW Switch will appear (this is the same window that will allow you to edit an 
existing HW Switch). From the upper left part of the window from left to right and going 
downwards, the following fields and controls are available: 
 

 
 

 allows you to close the "NEW HW Switch" / "EDIT HW Switch" window. 
 

Below this area, the HW Switch information area will appear: 
 

- "NEW HW Switch" or "EDIT HW Switch" field indicates if we are creating a new HW Switch 
or editing an existing one. 

 

- "Output Line": field allowing us to select the output line associated to HW Switch. The 

 button will give access to a list in order to make that selection. Once selected it will be 
shown whether the output is mono or stereo: 
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- "Select GPIs": field allowing us to select the GPIs (between 1 and 7) that will define the 
inputs routing according to their status. When the first GPI is selected a new field will 
appear in order to select the second GPI and so on (up to a maximum of 7). 

 

  
 

 Once selection is finished the  button should be pressed. 
 
Then the "HW Switch Content" are will show a list with the possible combinations of the 
selected GPIs status (in the example the physical GPIs 3 and 4 and the virtual GPI 1): 
 

 
 

Next one of the combinations should be selected (line is marked blue) and then, in "Available 
Logic Input Lines" list, the input line that will be routed to the associated output line when that 
combination of the selected GPIs status is detected. 
 

 
 

Once selection is done the  button should be pressed, so the input line will appear 
in the "HW Switch Content" list, where it will also be shown whether it's stereo or not: 
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This way you can select the different status combinations and then associate the desired inputs: 
 

 
 
In the example, we have defined the routing associated to 6 of the 8 possible status 
combinations of the 3 selected GPIs. 
 

Once selection is finished the  button should be pressed to confirm the creation or 
edition of the HW Switch and store it on the NETBOX unit. 
 

The  button allows you to discard the creation or edition of the HW Switch. 
 
The list of defined HW Switches shows the HW Switch identifier in the first column ("HW Id's"), 
double when the associated output line is stereo. The following columns shows the identifier 
number of the output line ("Id"), the line description ("Name") and whether it's stereo o not 
("Stereo"): 
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6.15. Remote IP. 
 
NETBOX 32 AD MX and NETBOX DSP have 16 physical opto-coupled GPI/O's, while NETBOX 
8 AD MX has 4 physical opto-coupled GPI/O’s. This section allows the user of "NetboxRTC" to 
define what physical GPI or GPO corresponds to what virtual GPO or GPI, i.e. a sort of 
translation table for physical to virtual GPI/O’s. Any modification made in this section will be 
stored in the non volatile memory of the NETBOX and will reset the communications between 
the SW and the unit. 
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To edit the virtual GPI to physical GPO association, click on the "Edit" button. The table header 
will turn green and allow the user to edit the IP address and the Id number for the virtual GPI 
expected and that should correspond to a GPO that would be physically connected to the 
NETBOX AD unit. The process is the same for the association of a virtual GPO to a physical 
GPI, a device that is connected to the NETBOX unit could send a command to GPI 1 that in this 
case translates to IP address 172.33.20.115 and Id number 22. 
 
When finished click on the "Apply Settings" button and the configuration will be stored in the 
non-volatile memory on the NETBOX. A message will indicate that the communications 
between the unit and the control application software is resetting: 
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6.16. Vumeters. 
 
This option of the "Config" menu allows you to add or edit a 
Multicast IP address for Vumeters. This configuration is stored 
in the non volatile memory of the NETBOX. When there is 
more than one NETBOX device in our network a different IP 
Multicast should be associated to each device. 
 
 
 
 
 
 
6.17. Netbox - IP Server RTC. 
 
The last option in the "Config" menu is the "Netbox - IP Server 
RTC". This is where you need to indicate or modify the IP 
address where the Service and Server application of the 
"NetboxRTC" application is hosted and running. This is usually 
also the location for the database system of the "NetBoxRTC". 
 
 
 
 
 
The virtual GPI’s sent from external equipment are point to the IP address of the NETBOX and 
not to the IP address of the "NetboxRTC" Server application. On the other hand, the NETBOX 
does not have sufficient system memory capacity to keep such vast and complex information, 
so you are relying on the Server application and the associated database to accomplish the 
configuring of the NETBOX matrix, according to salvos and macros. Therefore, you need to 
indicate to the NETBOX where this service is hosted so that when a virtual GPI and Id Number 
is received by the NETBOX (triggered remotely) it basically "relays" the received information to 
this IP address that is hosting the Server application. The Server application and database may 
handle several NETBOX devices. At the footer of the "NetboxRTC" application window this IP 
Address is visible: 
 

 
 
 

To edit the IP address, simply click on the  button. Now 
you can edit the IP address where the RTC server application 
and database are stored. This can actually be the same 
computer where the client application "NetboxRTC" is installed. 
Once the IP address has been completed, either click on the 

 button to confirm the address or the  button to cancel. 
This configuration is stored in the non volatile memory of the 
NETBOX. 
 
 
 
 
 
 

IMPORTANTE NOTE: In case the Server IP address is not defined or there is no connection to 
Server, no defined schedule could be executed and alarms or GPIOs won't work (although the 
physical/virtual GPIOs association described in section 6.11 of this manual would be operative). 
In that case the RTC application could be used to connect/disconnect crosspoints, 
protect/unprotect crosspoints or execute salvos and macros, but always manually. 
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7. DROP-DOWN MENU: Schedule. 
 
A schedule is a way to automate the execution of salvos and 
macros. What becomes important when using schedules is that 
the system time is synched correctly for example to an NTP or 
a station Masterclock. When you open the "Schedule" option 
from the "Schedule" drop-down menu, the schedule menu and list will appear: 
 

 
 

The buttons that will appear immediately beneath the application drop-down menus are: 
 

 

Allows to exit the schedule menu. 

 
Allows to refresh the schedule list. This is useful when several users are operating 
the "NetboxRTC" from different positions. 

 
Allows to open the "Add Schedule" dialogue and menu: 
 

 

 
 

From left to right, the first section is "SHOT PROPERTIES". This section defines all the basic 
properties in regards to time and dates of the scheduled task. Here you can activate the task or 
schedule by clicking or selecting the "Active task" tic box. When a task or schedule is active this 
means that it will be executed as programmed. If not active, the task is programmed but will not 
be executed. 
 
The "Task Description" field allows the user to edit a description for the scheduled task. Right 
beneath this field, you can define if the scheduled task should be executed always, only on 
holidays or only on working days, according to the calendar that you have defined in the 
"Holiday Calendar" option of the "Schedule" drop-down menu (more information at the end of 
this section). 
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You can define a date to start the task and the exact 
time that you want the task to be executed. You can 
also decide if this task should be executed as 
indefinitely or with a specific end date. The "Task 
start" field is a date select field and will return the 
users computer date and calendar; here you will 
select the date that the scheduled task should start 
being executed from. 
 
The "Execution Time" field is the time that you 
define that the scheduled task should be triggered 
or "shot". 
 
"Completing the task" area has two options: "Indefinite" and "Until the" date. "Indefinite" option 
will begin executing the scheduled task until you either make it inactive or you delete the 
schedule. The "Until the" field will define a date limitation or time window, i.e. from the task start 
until the last date of execution of the scheduled task. Even if the schedule remains active after 
the last date of execution defined, the scheduled task will not be executed again after this date. 
 

Immediately to the right and still in the section of "SHOT PROPERTIES" 
there are two options: "Every day" and "Weekdays". If you want to define 
specific weekdays for the scheduled task to be executed, you select the 
"Weekdays" option. This will provide access to the selection of the specific 
weekdays – Monday through Sunday. Simply select what weekdays the 
scheduled task should be executed on within the date and time limitations 
previously defined. 
 
 
 
 
The next section to the Right is 
"PROPERTIES". It has two buttons available: 
"Salvo" and "Macro". The "Salvo" button will 

open a window where the  button will give 
access to a list of the existing salvos in order to 
choose one of them. Once the salvo has been 
selected it will be shown in the field 
immediately below the button. Below this field 
there are two "Action" options that can be 
selected – "Take" or "Release", meaning that 
you either choose to "Take" the salvo or to 
"Release" the salvo. The last button in the 
lower right corner will return the "PROPERTIES" section to present the "Salvo" / "Macro" 
buttons and without further action, i.e. no changes will be made to the scheduled task. 
 
The "Macro" button will open a window where 

the  button will give access to a list of the 
existing macros in order to choose one of 
them. Once the macro has been selected it will 
be shown in the field immediately below the 
button. The last button in the lower right corner 
will return the "PROPERTIES" section to 
present the "Salvo" / "Macro" buttons and 
without further action, i.e. no changes will be 
made to the scheduled task. 
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The last section in the add and edit schedules window is the "ADD" section. This 
section only provides two buttons. The "OK" button will confirm all the changes 
and edits to the scheduled task and add the task to the database if you are in 
the add schedule mode. If you are editing an existing schedule (the section is 
now called "EDIT") it will overwrite this schedule with the changes that you have 
introduced. 
 
"Cancel" will cancel all edits to the current schedule. If you are adding a 
scheduled task to the list of schedules this will be ignored and no schedule 
added. If you are editing an existing schedule, all edits to this schedule will be 
ignored and discarded. 
 
 
Immediately below the scheduled task sections there is a grey field holding the text "Drag a 
column header here to group by that column". This becomes very useful when you have a long 
list of scheduled tasks as it allows us to group the tasks. For example if you drag the "Macro" 
header into the grey area the list view would change to something similar to this example. The 
tasks are now grouped by macros. 
 

 
 
 
 

 
 
If you expand the view for each of the macros in this new list, you will obtain a view as follows: 
 

 
 
The column headers are the following: 
 

• "Active": if the tic box is marked or selected, this means that the schedule is active, i.e. has 
been set to active and will be executed when the moment programmed to trigger the task 
arrives. If inactive or the tic box is not marked or selected, the schedule or the task has not 
been marked active and will therefore not be executed. 

 

• "Schedule": indicates when the task will be executed according to calendar. You can 
choose to execute this a working day ("WORK"), a holiday ("HOLIDAY") or any day of the 
week whether it's a working day or not ("ALWAYS"). 

 

• "Id": this is an automatic counter and is just showing the number (order of creation) of the 
schedule in the database. The numbering is automatic and a number order will never be re-
used, i.e. if you create schedule 20 and at a point in time delete this schedule, no schedule 
will receive number 20 as Id. 

 

• "Description": allows the user to provide a brief description of the schedule. 
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• "Salvo": indicates what salvo is used in the scheduled task. If this field is empty this means 
that no salvo has been defined to be part of the schedule. 

 

• "Macro": indicates what macro is used in the scheduled task. If this field is empty this 
means that no macro has been defined to be part of the schedule. 

 

• "Recurrence": indicates in binary the recurrence in a representation of seven days and with 
the first day being Monday. For instance, 0101011 would indicate that the schedule will be 
executed on Tuesday, Thursday, Saturday and Sunday and would not be executed on 
Monday, Wednesday and Friday. 

 

• "Begin Date": indicates the date from when the schedule will start to be executed. 
 

• "End Date": indicates the last date that the schedule will be executed on the time that has 
been configured. 

 

• "Begin Time": indicates the exact time when the schedule will be executed on the "Begin 
Date" and with the "Recurrence" that has been configured. 

 

• "Last Modified": shows the last date and time that the schedule was modified by any of the 
users with access to the "NetboxRTC" application. 

 
The "Info" button will open a similar view of the scheduled task as the add or 
edit schedules window.  
 
This is however merely an informative view of the schedule. To obtain information about the 
scheduled task you need to select the schedule form the list below and then click the" Info" 
button: 
 

 
 

 
The "Edit" button will open the selected schedule and allow the user to modify 
the specifics of the scheduled task. Select the scheduled task to be edited 
from the list and then click on the "Edit" button. The procedure is exactly the 

same as the one described previously to add a schedule. 
 

 
The "Run" button allows the user to run a schedule manually and at will, for 
example outside the established dates and time or an inactive schedule. 
Select the scheduled task form the schedule list and click on the "Run" button. 

The user will be prompted to confirm the execution of the scheduled task. 
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The "Remove" button allows the user to remove or delete a schedule from the 
list of scheduled tasks. Select the schedule to be deleted and click on the 
"Remove" button. The user will be prompted to confirm the deletion of the 

scheduled task. 
 

 

 
The "Server" button allows the user to consult the scheduled tasks that are 
programmed to be executed by the "NetboxRTC" Server. When the user 
clicks on this button the following window will appear: 
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This windows provides information concerning the scheduled tasks or jobs that are pending for 
the Server application. It will provide information concerning the date and time that the query 
was sent to the Server application, the date and time for the next shot or task scheduled to be 
executed by the Server and its property "On" or "Off". Below this information the window will 
show the scheduled tasks, sorted in ascending order by date and time. 

 
The last button in the schedules section is "Notify Changes". When clicking on 
this button the "NetboxRTC" application will request the "NetboxRTC" Server 
application to notify the Client application about any changes in the database 

and update the information concerning the scheduled tasks. 

 
Finally, the "Holiday Calendar" option of the "Schedule" drop-down menu allows you to define 
a calendar of holidays and working days in order to use it to define when should be executed 
the different scheduled tasks. It's possible to configure different years. 
 

 
 
In order to do that, simply click on the desired day and select on the drop-down menu that 
appears if that day will be a holiday or a working day. 
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8. DROP-DOWN MENU: Window. 
 
The last drop-down menu of the "NetboxRTC" 
application is "Window". This allows the user to 
organize the resulting workspace including its XY 
and vumeters views, as well as the precision 
vumeters, by re-sizing and placing these as per the 
user’s requirements. 
 
 
 
 
 
 
The available options are: 
 

• "Cascade": this option will cascade all the views on the monitor.  
 

• "Tile Horizontal": this option will tile all the views horizontally on the monitor. 
 

• "Tile Vertical": this option will tile all the views vertically on the monitor.  
 

• "Arrange Icons": if you have a large number of minimized views on our workspace and 
in different locations, this option will arrange all these icons. The icons representing the 
minimized views will be organized at the bottom of the main Window of the workspace. 

 

• "Minimize All": this option will minimize all the open views and arrange them as icons 
at the bottom of the main Window of the workspace. 

 
In the lower part of this menu the open views of the workspace are shown in order to provide a 
quick access to any of them. 
 

 


